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We are proud to announce the fourth edition of the Exploring Windows series in
conjunction with Microsoft® Office 2000. The series has expanded in two impor-
tant ways—recognition by the Microsoft Office User Specialist (MOUS) program,
and a significantly expanded Web site at www.prenhall.com/grauer. The Web site
provides password-protected solutions for instructors and online study guides
(Companion Web sites) for students. Practice files and PowerPoint lectures are
available for both student and instructor. The site also contains information about
Microsoft Certification, CD-based tutorials for use with the series, and SkillCheck®
assessment software.

The organization of the series is essentially unchanged. There are separate
titles for each application—Word 2000, Excel 2000, Access 2000, and PowerPoint
2000, a book on Windows® 98, and eventually, Windows® 2000. There are also four
combined texts—Exploring Microsoft Office Professional, Volumes I and 1],
Exploring Microsoft Office Proficient Certification Edition, and Brief Office.
Volume I is a unique combination of applications and concepts for the introduc-
tory computer course. It covers all four Office applications and includes support-
ing material on Windows 95/98, Internet Explorer, and Essential Computing Con-
cepts. The modules for Word and Excel satisfy the requirements for proficient
certification. The Proficient Certification Edition extends the coverage of Access
and PowerPoint from Volume I to meet the certification requirements, but
(because of length) deletes the units on Internet Explorer and Essential Comput-
ing Concepts that are found in Volume I. Volume II includes the advanced fea-
tures in all four applications and extends certification to the expert level. Brief
Office is intended to get the reader “up and running,” without concern for certi-
fication requirements.

The Internet and World Wide Web are integrated throughout the series.
Students learn Office applications as before, and in addition are sent to the Web
as appropriate for supplementary exercises. The sections on Object Linking and
Embedding, for example, not only draw on resources within Microsoft Office, but
on the Web as well. Students are directed to search the Web for information, and
then download resources for inclusion in Office documents. The icon at the left of
this paragraph appears throughout the text whenever there is a Web reference.

The Exploring Windows series is part of the Prentice Hall custom-binding
(Right PHit) program, enabling instructors to create their own texts by selecting
modules from Volume I, Volume II, the Proﬁcien‘ Certification Edition, and/or
Brief Office to suit the needs of a specific course. An instructor could, for exam-
ple, create a custom text consisting of the proficient modules in Word and Excel,
coupled with the brief modules for Access and PowerPoint. Instructors can also
take advantage of our ValuePack program to shrink-wrap multiple books together
at a substantial saving for the student. A ValuePack is ideal in courses that require
complete coverage of multiple applications.

Instructors will want to obtain the Instructor’s Resource CD from their Pren-
tice Hall representative. The CD contains the student data disks, solutions to all
exercises in machine-readable format, PowerPoint lectures, and the Instructor
Manuals themselves in Word format. The CD also has a Windows-based test gen-
erator. Please visit us on the Web at www.prenhall.com/grauer for additional
information.
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LOOKING AHEAD: of the fields that pertain to each location: LocationlD, Location, Address. State,
A RELATIONAL DATABRASE Zipcode, and Office Phone, One field, the LocanonlD), appears in both Employees

and Locations tables and links the two tables to one another. In similar fashion.
the Titles table has the information for cach title: the TitlelD, Title, Descniption,
Educanion Required, and Mimmum and Maximum Salary. The TitleID appears in
both the Employees and Titles tables to link those tables to one another.

It sounds complicated, but it s really quite simple and very elegant. More
importantly. 1t enables you to obtain detailed information about any emplovee.
location, or title. To show how it works, we will ask a series of questions that
require you 1o look in onc or more tables for the answer. Consider:

The Bookstare and Employee databases are both examples of simple databases
in that they cach contained only a single table, The real power of Access. how-
ever, is derived from multiple tables and the relationships between those tables.
This type ol database is known as a relational database and is illustrated in Fig-
ure 1.9. This figure expands the ongmal Employee database by adding two tables,
for locations and titles. respectively.

T'he Emplovees table m Figure 1.94 1s the same table we used at the begin-
ming ol the previous excerase. except for the substitution of a LocationID and

. e > " i o ' = & -
TitlelD for the location and title, respectively. The Locations table in turn has all Query: At which location does Pamicla Milgrom wark? What is the phone num

ber of her office”
Answer: Pamela works in the Boston office, at 3 Commons Blvd., Boston, MA.

Y e | FirstName | LocationiD| "7=7 | Salary | Gender (2190. The phone number is (617) 123-4444.
000-01-0000 _|Milgrom F'Em.BJE LO2 l = $57.500 F Did you answer the question correctly? You had to search the Employees
000-02-2222 [Adams Jennifer LO1 U3 $19,500 F table for Pamela Milgrom to obtain the LocationlD (LO2 in this example) corre-
111-12-1111_ |Johnson James LO3 101 $47,500 M sponding to her office. You then searched the Locations table for this LocationlD
123-45-6789 |Coulter Tracey LO1 10z $100,000 F to obtain the address and phone number for that location. The process required
222.23-2222 |Mariin Billy LO4 10z $125.000 M you to use both the Locations and Emplovees tables. which are linked to one
222:52 5555 St [Man 03T | 2500 ] F JAverags o g g e o e
333-34-3333_|Manin Ann L02 01 | $49500 | F__ |Average e e = - - 9
333-43-4444 |Smith Frank LO1 T01 $65,000 M Good
333-66-1234 [Brown Marietta LO1 RE $18,500 F Poor Query: Which employees are managers?
444-45-4444 |Frank Vernon LO4 70 $75,000 M Good Answer: There are four managers: Pamela Milgrom, Tracey Coulter, Billy Mar-
555-22-3333 |Rubin Patricia L02 101 $45000 | F  |Average lin,:and David: Adamson
85 _|Charies Kenneth Loz - $40,000 M Poor I'he answer to this question 15 based on the one-to-many relationship that
776-67-6666 |Adamson David LO3 -— $52.000 M Poor exists between litles and emplovees. One utle can have man}r- employees, bul a
777-78-7777 _|Marder Kelly LO3 $38,500 F Average | given employee has only one title. To answer the query, you search the Titles table
for “manager” to determine its TitlelD (TO2), You then go to the Employees table
(a) The Employees Table and select thosegecords that have this value in the TitlelD field.
The desig®ol a relational database enables us to extract information from
= _ multiple tables in a single query, Equally important. it simplifies the wav data s
= — changed i that modifications are made in only one place. Consider:
(404) 333-5555
LO2 Boston 3 Commons Bivd MA 02190 (617) 123-4444 Query: Which employees work in the Boston office” What is their phone num-
LO3 Chil‘.:ﬂgﬂ 500 Loop @hway IL 60620 (312) 444-6666 :11;1:!:: T;ﬁ:aﬂrj.;l:a:ﬁ:; 1::-]:1“ be necessary if the Boston office were
. 0 gel ¢ C - &b
LO4 Miami 210 Biscayne Bivd FL 33103 (305) 787-9999 Answer: There are four employees in Boston: Pamela Milgrom, Ann Manin,
Patricia Rubin, and Kenneth Charles, each with the same number (617
(b) The Locations Toble 123-4444). Only one change (in the Locations table) would be neces-

sary if the phone number changed.

Once again. we draw on the one-to-many relationship between locations and

- - - emplovees. Thus, we begin in the Locations table where we search for “Boston™
_IUE Manager A supervisory ... |Four year degree $50,000 $150,000 Lo gclcrmine is LmatiufllD (L02) and phone number (617 123-4444), Then we go
105 |Trainee An entry-level ... |Two year degree $18,000 $25,000 to the Employees table to select those records with this value in the LocationlD
field. Realize, however, that the phone number is stored in the Locations table,
(c) The Titles Toble Thus, the new phone number 1s entered in the Boston record. where it 1s reflected
automatically for each employee with a LocationlD) of LO2 (corresponding to the

AGURE 1.9 A Relotional Dalabose Baston office).
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STEP 2: Create the Relationships

» Maximize the Relationships windows so that you have more room in which
1o work. Click and drag the title bar of each table so that the positions of the

tables match those in Figure 1.10b. Click and drag the bottom (and/or right)

border of each table so that you see all of the fields in each table.
» Click and drag the LocationID field in the Locations table field list to the

LocationlD) field in the Employees field list. You will see the Edit Relation-
ships dialog box. Check the box to Enforce Referential Integrityv. Click the

HANDS-ON EXERCISE 4
A Look Ahead
Objective: To open a database with multiple tables; to identify the oneto-
many relationships within the database and to produce reports based on those
relationships. Use Figure 1.10 as a guide in the exercise.

Create button to create the relationship.
» Click and drag the TitleID field in the Locations table field hist to the TitleID
field in the Employees hield list. You will see the Edit Relationships dialog
box. Check the box to Enforce Referential Integrity as shown in Figure 1.10b.

Click the Create button to create the relationship.
» Click the Save button on the Relationship 1oolbar to save the Relationships

STEP 1: Open the Relationships Window
» Start Access, click the More Files option button, and click OK. If Access is
window, then close the Relationships window.

already open, pull down the File menu and click the Open command. Open

the Look Ahead database in the Exploring Access folder.
» The Tables button should be selected as in Figure 1.10a. The database con-

tains the Employees. Locations, and Titles tables.
» Pull down the Tools menu and click the Relationships command 10 open the
Relationships window as shown in Figure 1.10a. (The tables are not yet vis-
ihle in this window . )

» Pull down the Relationships menu and click the Show Table command (o dis-
play the Show Table dialog box. Click (select) the Locations table (within the
Show Table dialog box) then click the Add button 1o add this table 1o the
Relationships window.,

» Double click the Titles and Employees tables to add these tables to the Rela-

tonships window.
» Close the Show Table dialog box,

(b) Create the Relationships (step 2)

Click Maximize button -
Select table
FIGURE 1,10 Hodeon x4 (ontned
Click Add buon — THE RELATIONSHIPS ARE VISUAL
o pen the et Wi (s 1 Ot TR & & Gac 0 sty “sticmahiy botmeca e Loosions
FIGURE 1.10  Honds-on Exercse 4 ~snd Empioyess tables.
C MICROSOFT ACCESS 2000 [~ —L_ CHAPTER 1: INTRODUCTION T0 MICROSOFT Access |0
||I|l - - % .-_______‘—'—-—._
: . Student —
A total of 30 in-depth tutorials | o Bty ] N
provide hands-on instruction at the P " || StudentMastery 000
. Addrgay =l . Liat Mo |
computer and guide the reader — || EEeEea,
every step of the way. Each _— | | & = == = |
B pngt . - ol
tutorial is illustrated with e | |- = e oy /
0 f— — oo, —
annotated screen captures and ol | S 5 o= =
expanded through appropriate [ - = gme =
e JI| JI :: : f:::':l ‘:-,.__:""'
e ] J| ;.:_ E E:‘E E_ r.'ll

tips that further explain the task at
ru;(dn..-.,m D N B
\h—-.. .
ﬁllﬂ.m —

hand.

Yo g = o T——
rﬂ' s Llst | },'I. ﬂ_\—\\
. . . L. = ] Major ' E-i_ -—--_-_-__‘_h-—_‘_-_'_'_“—‘—' —_—
All discussions are accompanied L B el -
- r::m rm iy " | S T — /
Paiupy By i .. PP ara
I|| Bolorta C— I ;r: :; aae / m ::‘ -
| ] s = |
| le | — e |
| S S &

by multiple illustrations that
explain the underlying conceptual

material. This example describes
the different types of reports that
~— || - =
o D el
| = 2

“'h mm
|

can be created from a database.

The reader learns concepts as well
- — || __. /

as keystrokes, which in turn
increases his or her proficiency in
/ FIGURE 71 Report Types

Access.

= -
I —
i L

CHAPTER 3.
INFORMATION fo4 THE DaTs :
hasg =
L AVS

.. =

FREFA(E f f;$



University of Miami
Book Store

United States
by Region

Publisher
ISBN A
e Title
ListPrice

Macmillan Publishing

P
repared by Gregg K
_Region
Name
Middle Atiantic Capital Popu
lation
opulati
Maryiand S on Density | -$6686-12
New Jersey Annapoiis 666,168 B6-127-6
an‘rm: Albany 7,730,188 10,577 ﬁg'aﬁ ¢ Hardware Bible
sylvania Harri 17.990,45 7,838 06 . £35.00
Total for R i 11,861 54:.'5] 49,576 906.50 R Number of Books:
A eglon 43 45,333 362.89 - . Average List ]
sio s verage for Region ,049,922 262.10 0-07-029387-2 Price:  $35
m a,m'm 115I3?9 ) {j._l'..‘j‘ tu = El"“"‘“ﬂ' — 'm
Colorado Phoanix 3 565 23,076 477 0 ‘I- Aol Martimez Internet Literacy
Itaha Denver " 228 .48 17 -54048-9 Cretln
' 11 ng Ahead ; S45.00
Montana Bolea SARRASY 1 s 0-07.070 Rothsten Ac Ny
| Nevada Helena 1,006.748 U247 32.18 AE-3 Wil Ace the Techmical | 339.95
W 7068 06 B31557 31.680 iHnrd The C Nery icw o
Utah Santa Fe 1.201.833 138 2.05 % Reader
Salt Lak 1.515,069 110,540 543 IPremt i Nu $15.75
| Total for r hiad 45; A4 9186 12.45 013 Average Lis 4
New A Region 13 ,588 97 9 D 13-011 10G-7 G 1 Price: $3).41
Cormibo 707,347 10?‘9@5 : 0050 = Grauer/Barber ploring Microsoft Office 2000
Maine Hartford . ' 16.19 HOUI%0  Graver/Bar Exploring Excel 2000 $45.00
Massochusetis  Boston. Hgd: 5.009 ' 0130118168 G r Exploring Mic $28 05
New Baston 1.227.928 v Ciruuer/Barbe . g Microsoft Office 2 .
%3 & 0-13-02 J ice 2000
A Corcii 6,016,425 215 56 .24 0476-5 G Exploring Pow : $45.00
de lsland  Provide 1,109,252 B.257 36.97 0-13-02 irauer/Barber ~ erPoint 2000 |
Vermont S nce ' ﬂﬁﬂrqm 9.304 728 65 " 3-020489-7 Grauer/Barbe Exploring Access 200K) $28 98
Total f 'lFl'EiIar 552??53 1.214 11922 -1 3-065541 -4 G J Elplnﬁng W 2 $28,95
Av or Hﬂﬂlun 13.2 9 609 826.58 0-11- -0 iraver/Barber Explo 2000 £
North C rrage for Region ,206,943 66.608 58 57 o11e : | Graver/Barbes ring Windows 3.1 28.95
entral 2,201,157 ' 3-754193-7 G Exploring Windo £24.95
I 1,10 0-13-754 mct/Buber Ex waNe =
glenc Sp 404.37 FIAA-) Cirauer/B ploning Windows 98 $28.95
lowa Immmllﬁ 5‘ 602 56.400 *13 Grauer/B 1 ng Word 97 2895
K Des Moi 544 159 - -13-754227-5 . Exploring Exc $30.9
ansas nes 38 79 202.67 Cirmue g Excel 97 95
Tﬂpﬂha 2,776.755 1 ()-13-7542 r/Barber E E
| 2 477 574 56.290 152.77 g 54215-6 Grauer/Barbe xploring Access 97 $30.95
' 4 13- 5 r o
Friday, February 19, 1999 B2.264 33?3 T90817-2 Crnaet] Viik Exploring PowerPaint 97 $30.95
ar COBOL: From Micro 1o M $30.95
anframe
Nasnl $5295
AGURE 31 rage . 6i3 lmwﬂ - 14
E2.13 o Unied St Dutchess (Eranie 3 Hetpres
se 3]
Fridav. F
~ MICRO ¥, February 19, 1999
FIGURE 3.14
14 The Book — Page 1 of 2
— pat —
1 \
EVEry Ch FROM THE DATABASE |
E | i I_. 3 ':"-':"-.
apfer End - e M_
practice exerci s with multiple
_— xercises to reinforce t
lﬂland . he
0V0|d .y
on repetition fr .
€ SemeSter fO ﬂ'le n xi. L om The United States of Amerka
ob ectiv . e = There G ‘e - - ' v H T # "
e nu h I h . re what is the wotal population of the pited State Can you name
. p e-cnoice the 13 original states or the last Bve states admitted 10 the Union? Do you know
qUESfIOns gu‘ d I the 10 states with the tnghest puputauun ar the hve Jargest states in lerms of area’
e . 4 ! cOom pute which stales have Lhe highesl population densily (people per square mile)?
Xercises, a d I J The answers 10 these and other questions can be obtained from the U nited
. ’ n ess Sfructu ed grates database that 18 available on (he data disk. The key 1© {he assignment is o
StUdles r cqase use the 10p Values property within @ query that himts the number of recor
’ returned 10 the dynaset. Use the Jdatabase 10 greale several reports that you think
will be of interest 10 the class
The case Si'UCI. The SupeT Bow!
ies chall
readEr b cna enge ‘rhe , How many rimes has the NFC won the Supet gowl? When was the last time the
. y eXfendin ; h AFC won’ What was the largest margin Of victory”? What was the closest game’
n ihe h g t € mﬂfe | I e TR what s the most ponts «cored by WO (eams in one game’ How many (imes have
C apter Th . ra | — the Miami Dolphins app«.-:tud'.’ How many ymes did they win? Use the data n
a . e Web Icon o 1 the Supet powl database 1o create @ (rivia sheet On the Super Bowl, then incot-
ppeﬂ rs WI']e“ " rate your analysts into @ leuer addressed 10 gC Sports. € opvince them you
d' ever the read " - | are a super fan and that you ment two nckets 10 pext year's game. Go to the home
Irected 1.0 'l'h W eris _ page of the National Football League (WWW afi.com) 10 pbtain score(s) from the
most recent amels) o ¥ ate our 1:abic \{ necessary:
e o e or|d Wlde W g pda ble if necessan
source eb
of additi |
itional matertial Mail Merge
’ A mail meres (akes the tedium oul of sending form letiers. a6 il creates the same
UL£ fetter many LIMES, changing the name. address. and other information as appro-
priate from letier 0 letter. The form leuer i created in @ word processor (€2
Microsolt word), but the data file may e taken from an ACCESS Lable or query:
{Ise the Our Students databasc 3% ihe basis ot wo different {orm letters sent 1o
of students. e first letter is 10 congratulate students O the
i ad leter 15 3 warning 10 crudents on

Object Linki
inking a
g and Embedding
ywo different groups by
-pA of 3500 igher). The 5¢
(GPA _lrhg. 'p. "_wcf

Dean s list

OLE) i .
(OLE) is also highlighted
academic probation Gy
gng
as objects

ersus Compies
.nted, and thus unneccﬁsarily large,

-+ o artant, therefore: 10 pert

cize (enabling 3 4 to back it up on a

e Our Srudents datd-

ple ohjects: &£
_ord the file stZ€ of the

Cﬂmpuchng v

(C.Be
odically compac
floppy disk). Choose !
pase used 10 this chaptet Use the Windows Explo
Jdatabase a5 it presently exists. Start Access. open (the database. pul
Tools meny and select \ mpact the Jdatabase, then record
the size of the mpress & compacted
database (USHIS
requircmum for disk storag=
nstructor Ty compactin ing al
(er appreciate these rechmques

EXP
LORING MICROSOFT ACCESS 2000



Exploring Microsoftf® Access
2000 goes beyond the Expert
level in the MOUS (Microsoft
Office User Specialist) program to
include a capstone chapter on
VBA.. This material enables the
reader to take Access to the next
level as he or she learns how to put

VBA code behind Access obijects.

of :
in cre 10 Microsop

Students are exposed to a wide
variety of practical applications

with which they can identify. The

case study on a sports league
appears in Chapter 7 and includes
material on multilevel switchboards
and macros.

database into two files—one containing the tables and the other containing the
remaiming objects (the forms, reports, quenes, and macros). The tables are then
linked to the other objects through the Link Tables command. It sounds compli-
cated but this approach has several advantages, as you will see.

The chapter also covers macros and prototyping, two techmgues that are
used by developers in creating applications. A macro automales common com- Click About Sports bution o
mand sequences and further simplifies the system for the end user, Prototyping is display informational messoge
used in conjunction with developing the vanous switchboards to demonstrate the
“look and feel” of an application, even before the application 1s complete. Three
hands-on exercises are included in the chapter to progressively build the applica-
tion as you develop your skills in Access.

Hyperlink . R
CASE STUDY: A RECREATIONAL SPORTS LEAGUE
You have probably played in a sports league at one time or another. whether in
Little League as a child or in an intramural league at school or work. Whatever
the league, it had teams, players, and coaches. The typical league registers the Click Teamns button to
players and coaches individually then holds a draft among the coaches to divide disploy Team form '

the players into teams according to ability. The league may have been orgamized
informally, with manual procedures for registering the participants and creating
the teams. Now we automate the process.

Let's think for a moment about the tables and associated relationships that
will be necessary to create the database. There are three tables, one each for play-
ers, coaches, and teams. There is a one-to-many relationship between teams and
players (one team has many players, but a player is assigned to only one team).
There is also a one-lo-many relationship between teams and coaches (one team
has many coaches, but a coach is assigned to only one team).

In addition to the tables, the database will contain multiple forms, quernies,
and reports based on these tables. A Players form is necessary in order to add a
new player, or edit or delete the record of an existing player. A similar form should
exist for Coaches. There might ulso be a sophisticated main and subform combi-
nation for the Teams table that displays the players and coaches on each team, :
and through which data for any latr:lr:}{'l"f:aml? Piayt:r. or Coach) can be added. Add, edl, dalete o teom
edited, or deleted. And, of course, there will be a variety of reports and gueries.

Let’s assume that this database has been created. It would not be difficull
for a person knowledgeable in Access to open the database and select the various . —
objects as the need arose. He or she would know how to display the Database Add, edi, delate o coach
window and how lo select the vanous butlons in order to open the appropnate
object. But what if the system is to be used by someone who does not know
Access, which s typically the case” You can see that the user interface becomes Add, edit, delete a player — '
the most important part of the system, at lcast from the viewpoint of the end user.
An interface that is intuitive and easy to use will be successful. Conversely, a sys-
tem that is difficult to use or visually unappealing is sure to fail.

Figure 7.1a displays the switchboard that will be created for this application.
We have added a soccer ball as a logo, but the application applies to any type of
recreational sports league. The interface is intuitive and easy to use. Click the
About Sports button, the first button on our menu, and the system displays the
informational screen we like to include in all of our applications. Click any other
button, and you display the indicated form. Click the Teams button, for example,
and you see the lorm in Figure 7.1b where you can add a new team, view, edit,
or print the data for any existing team, then click the Close Form button to return
to rhe main menu, : FIGURE 7.1 Building o User Interfoce

The swilchboard in Figure 7.1a exists as a form within the database. Look
closely. however, and you will see it is subtly different from the forms you have
developed in previous chapters. The record selector and navigation buttons, for
example, have been suppressed because they are not needed. In other words, this

(b) The Teams Form

© T MicROSOFT ACCESS 2000 CHAPTER 7: BUILDING APPLICATIONS
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INTRODUCTION TO
MICROSOFT ACCESS.

WHAT IS A DATABASE?

OBJECTIVES

After reading this chapter you will be able to:

1. Define the terms field, record, table, and database.

2. Start Microsoft Access; describe the Database window and the objects
in an Access database.

3. Add, edit, and delete records within a table; use the Find command
to locate a specific record.

Describe the record selector; explain when changes are saved to a
table.

Explain the importance of data validation in table maintenance.

6. Apply a filter (by form or by selection) to a table; sort a table on one
or more fields.

7. Describe a relational database; identify the one-to-many relationships
that exist within a database.

OVERVIEW

All businesses and organizations maintain data of one kind or another.
Companies store data about their employees. Schools and universities
store data about their students and faculties. Magazines and newspapers
store data about their subscribers. The list goes on and on, and while.each
of these examples refers to different types of data, they all operate under
the same basic principles of database management.

The chapter introduces you to Microsoft Access, the application in
the Microsoft Office suite that performs database management. We
describe the objects in an Access database and show you how to add, edit,
and delete records to a table. We explain how to obtain information from
the database by running reports and queries that have been previously
created. We discuss how to display selected records through a filter and
how to display those records in different sequences. And finally, we pro-
vide a look ahead, by showing how the real power of Access is derived
from a relational database that contains multiple tables.
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